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Preface

Organization of
documentation

SINUMERIK documentation is organized on 2 separate levels:
•  General Documentation
•  User documentation

Target group This Manual is intended for machine-tool users. This publication
provides detailed information that the user needs to operate this
application for the SINUMERIK 840D/840Di/810D controls.

Hotline If you have any queries, please contact the Hotline given below:

A&D Technical Support Tel.: ++49-180-5050-222
Fax: ++49-180-5050-223

If you have any questions about the documentation (suggestions,
corrections), please send a fax to the following fax address or email:

A&D Technical Support Tel.: ++49-9131-98-2176
Email: motioncontrol.docu@erlf.siemens.de

Fax form: See Suggestions/Corrections Sheet at the back of the
document.

Internet address
http://www.ad.siemens.de/sinumerik

Objectives This Operator's Guide describes the CAD Reader PC application and
how to use it. The CAD Reader enables you to convert drawings
constructed with a CAD system for further processing on a
SINUMERIK control. The format of the imported file is DXF (Drawing
eXchange Format) from which contours or drill points are filtered out.

Note

The CAD Reader can be used for systems with the following software
versions:
Controls SINUMERIK 840D/840Di/810D All versions
Target systems HMI Advanced or HMI Embedded SW 5.1 and higher

ShopMill and ManualTurn SW 5.3 and higher
ShopTurn SW 6.2 and higher

Please note the supplementary conditions regarding the number of
cycles.
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Search tools A table of contents and keyword index are provided to help you access
information quickly.

SINUMERIK 840D
powerline

Improved performance versions
•  SINUMERIK 840D powerline and
•  SINUMERIK 840DE powerline
are available from 09.2001 onwards.
For a list of available powerline modules, please refer to the
Hardware Description:

References: /PHD/ Configuring Manual SINUMERIK 840D

SINUMERIK 810D
powerline

Improved performance versions
•  SINUMERIK 810D powerline and
•  SINUMERIK 810DE powerline
are available from 03.2002 onwards.
For a list of available powerline modules, please refer to the
Hardware Description:

References: /PHC/ Configuring Manual SINUMERIK 810D

Standard scope This Operator's Guide describes the functionality afforded by standard
functions. Differences and additions implemented by the machine-tool
manufacturer are documented by the machine-tool manufacturer.

Please consult your local Siemens office for more detailed information
about other SINUMERIK 840D, 840Di and 810D as well as the
publications that apply to all SINUMERIK controls (e.g. Universal
Interface, Measuring Cycles ...).

Other functions not described in this documentation might be
executable in the control. This does not, however, represent an
obligation to supply such functions with a new control or when
servicing.

Applicability Catalog NC 60 is the definitive document as regards the validity of
functions
/BU/ Ordering Information, Catalog NC 60.
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Structure of descriptions All functions and operating options have been described according to
the same internal structure as far as this is meaningful and
practicable. The various levels of information have been structured so
that you can find the information you are looking for quickly.

1. Function

This theoretical section is primarily intended as learning material for
the NC beginner. It provides important information that will help you to
understand the principle of operating functions.
You should work through the manual at least once to get an idea of
the scope of the functions and capability of your SINUMERIK control.

2. Operating sequence

This section provides a clear diagrammatic description of the
sequence of key inputs required. If inputs have to be made at
individual stages of the sequence or if you require additional
information, you will find this next to the key illustrations.

3. Further notes

For safety reasons, some of the functions are protected from access
by unauthorized persons. The machine-tool manufacturer can
influence or modify the described functions. Please follow the
instructions of the machine-tool manufacturer.
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Explanation of symbols

Function

Operating sequence

Further notes

Cross-references to other documentation or sections

Danger notes

Additional notes or background information

Ordering data option

Explanation

Description of syntax

Programming examples
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The following special notes have been used in this documentation:

Notes This symbol appears in this documentation whenever it is necessary to
draw your attention to an important item of information.

In this documentation, you will find this symbol with a reference to an
ordering option. The function described is executable only if the control
contains the designated option.

Warnings The following warning notes with varying degrees of severity are used
in the documentation:

Danger
Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury or in substantial property damage.

Warning
Indicates a potentially hazardous situation which, if not avoided, could
result in death or serious injury or in substantial property damage.

Caution
Used with the safety alert symbol indicates a potentially hazardous
situation which, if not avoided, may result in minor or moderate injury
or in property damage.

Caution
Used without safety alert symbol indicates a potentially hazardous
situation which, if not avoided, may result in property damage.

Notice
Used without the safety alert symbol indicates a potential situation
which, if not avoided, may result in an undesirable result or state.

References This symbol appears whenever specific information can be found in
other literature.
A complete list of available literature is included in the Appendix of this
Operator's Guide.
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Principle Your SIEMENS 840D/840Di/810D has been designed and constructed
according to state-of-the-art technology and approved safety
regulations and standards.

Additional equipment The applications of SIEMENS controls can be expanded by adding
special additional devices, equipment and expansions supplied by
SIEMENS.

Personnel Only appropriately trained, authorized and reliable personnel may
be allowed to operate this equipment. No-one without the necessary
training must be allowed to operate the control, even temporarily.

The corresponding responsibilities of personnel who set up, operate
and maintain the equipment must be clearly defined and adherence to
these responsibilities monitored.

Procedure Before the control is started up, the personnel who will work on the
control system must become thoroughly acquainted with the
Operator's Guide. It is also the duty of the equipment operator to
constantly monitor the overall technical condition of the control
(outwardly apparent defects or damage as well as changes in
operating performance).
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Service Repairs must be carried out by personnel who are specially trained
and qualified in the relevant technical subject according to the
information supplied in the service and maintenance guide. All relevant
safety regulations must be followed.

The following is deemed to be improper usage and exempts the
manufacturer from any liability:

Any application which does not comply with the rules for proper usage
described above.

If the control is not in technically perfect condition, or is operated
without due regard for safety regulations and accident prevention
instructions given in the Instruction Manual.

If faults that might affect the safety of the equipment are not rectified
before the control is started up.

Any modification, bypassing or disabling of items of equipment on
the control that are required to ensure fault-free operation, unlimited
use and active and passive safety.

Improper usage gives rise to unforeseen dangers to:
•  Life and limb of personnel,
•  The control, machine or other assets of the owner and the user

�
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1.1 The CAD Reader product

Description

The CAD Reader program converts files of CAD drawings into
contours or drill patterns for SINUMERIK 840D/840Di/810D.

Functions
The following functions can be converted by the CAD Reader:
•  Import DXF files
•  Hide graphics layers
•  Automatic contour trace
•  Optional workpiece zero per contour/drill point
•  Several contours/drill points can be selected simultaneously
•  Create and convert contours or drill patterns for ShopMill,

ShopTurn, ManualTurn, HMI Advanced or HMI Embedded
•  Display existing contours/drill points in geometry processor/cycles

support.

1.2 General function

General function

The CAD Reader enables you to convert drawings constructed with a
CAD system for further processing on a SINUMERIK control. The
format of the imported file is DXF (Drawing eXchange Format) from
which contours or drill points are filtered out. Any information that is
not needed for further processing (such as dimensions, hatching,
labels, borders) can be removed.

Existing contours or drill patterns are converted such that they can be
interpreted by the geometry processor or the cycles support.
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1.2.1 Scope of application

Scope of application
The CAD Reader is suitable for the following HMI target systems:
•  HMI Advanced or HMI Embedded (Standard) SW 5.1 and higher
•  ShopMill SW 5.3 and higher
•  ShopTurn SW 6.2 and higher
•  ManualTurn SW 5.3 and higher
DXF files converted by the CAD Reader program can be processed by
NC controls with G code programming such as SINUMERIK
840D/840Di/810D.

Notes
•  The HMI Advanced or HMI Embedded (standard) target system,

ShopMill, ShopTurn or ManualTurn must be defined before the
contour is traced.

•  When ShopMill or ShopTurn is defined as the target system, you
are prompted to enter a contour name before the contour is
traced.

•  Please observe the boundary conditions applicable to the relevant
target system. This applies in particular to the number of contour
elements as regards the geometry processor or cycles.

Further information about suitable HMI target systems:
/BAD/, HMI Advanced Operator's Guide
/BEM/, HMI Embedded Operator's Guide
/BAS/, ShopMill Operator's Guide
/BAT/, ShopTurn Operator's Guide
/BAM/, ManualTurn Operator's Guide

1.2.2 Software

Software
The software is compatible with operating systems Microsoft
Windows 95, Windows 98, Windows Me, Windows NT 4.0 and
Microsoft Windows 2000.
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1.2.3 Formats

Input format
Basic input format: DXF (Drawing eXchange Format)

DXF input formats as defined by AUTOCAD® are supported.

Output formats
After conversion, NC programs can be saved as file types
•  MPF
•  SPF
•  ARC.

When a file is saved, the CAD Reader creates G code (NC blocks)
from the selected contour. This code can be processed directly with
the SINUMERIK.
Comment blocks which can be processed by the geometry processor
or the cycles support are saved at the same time.
Imported contours can be recompiled or modified by means of the
geometry processor.

Drill holes are generally generated in cycles format and can thus be
recompiled on the control.

1.2.4 Plane generation

Generation of relevant data
When the relevant data are saved as part program blocks, they are
converted to MPF format by the geometry processor and the
appropriate planes G17, G18, G19 are generated.

Notes
•  Technology data are not specified in the CAD Reader, but must

generally be programmed in the editor or the geometry processor.
•  NC milling programs are created only in the 2D machining plane.

The infeed axis must be programmed later.

■
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2.1 General operating procedures

Toolbar

You can select the toolbar in the global header by clicking "View →
Show Toolbar".
Further settings are described in Section 3.1.

General operation
All the CAD Reader functions can be operated with both the keyboard
and the mouse. The right mouse button is equivalent to the "ESCAPE"
function with which you can reset activated menus or functions.

Operating sequence

Open DXF files
Select a CAD drawing by clicking Open.

Save the program
You can save contours you have created as a file type in
•  MPF format(∗ .mpf)
•  SPF format (∗ .spf)
•  ARC format(∗ .arc) (SINUMERIK archive)

Back
The last action in the contour trace is undone, either element by
element or to the last intersection depending on your selection.
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2.2 Define the zero point

Set the zero point
To output the contour as an NC program, you must specify a zero
point in the drawing since, in most cases, this will deviate from the
zero point of the DXF file.

Element Center
Element Start
Element End
Free Input
Mouse Position

You have the following options for defining the zero point:

•  Automatically at element center
•  Automatically at element start
•  Automatically at element end
•  Direct input of coordinates e.g. X100, Y100
•  Any position selected with the mouse

2.3 Contour trace

Set the contour start point
Element Center
Element Start/End Point
Mouse Position

Contour trace with start and end points
The start and end points of the contour to be created are selected as a
function of the initial position of the applied technology:
•  Automatically at element center
•  Automatically at element start/end point
•  Directly selected with the mouse

Example
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1. The contour direction
is determined by the defined start point •→
and the remaining contour selection. When the contour is traced,
an attempt is made to automatically select as much of the contour
as possible.

2. Selection in the event of conflict
If the automatic contour trace function cannot determine a
following element clearly, interactive mode is activated. You will be
prompted to identify the next element in the contour.

3. Full circle as contour
The contour trace can integrate a full circle in both directions.

Set the contour end point
Element Center
Element End Point
Mouse Position
Current Position

4. Set the end point
You can set and save the end point at any contour trace element
of your choice.

Further notes

•  Full circles can be saved as a contour or as drill points.
•  You can cancel the contour trace either via the keyboard with the

"Esc" key or via the right mouse button.

Set the contour label
Before the contour is traced, you can set labels by entering start and
end labels.

The CAD Reader switches to interactive mode if you specify a label
which has already been assigned, i.e.
• when the trace is performed on contours that are already selected
• when the contour is attached to files which already contain the

label.
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2.4 Drill points

Set drill points
1. Full circle as drill hole

You can select a full circle with the Drill Points function. The G
code generated is output in the cycle format.

Any Position
Row of Holes
Hole Circle
Hole Matrix

Drill points start
2. You can select the drill pattern to parameterize drill points as

• any drill positions
• according to cycle
• according to cycle
• according to cycle.

For further information about drill cycles and drill patterns, please see:
/PGZ/, Programming Guide Cycles, Chapter 2

Drill points end
3. This button accepts drill points selected from the drill pattern.

2.5 Manipulate graphic display

Select the processing area:
If the file contains a large number of supplementary drawings such as
cuts, hatching, labeling, detail views, borders, etc., you can reduce the
number of elements by using a "lasso" to select a processing area.

Deselect the processing area:
You can click this button to deselect the processing area again.
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Zoom / keys "+" and "– "
You can use the mouse button to select a zoom area within a drawing.
By clicking the button and using a "lasso" or the "+" and "–" keys, you
can increment or decrement the magnification of the zoomed area.
You can move the zoomed area with the cursor keys.

2.6 Process an imported file

Redraw / space bar
Redisplays the current drawing in optimized form according to the
layer selection.

Geometry
When you click this button, the coordinates for the selected element
as defined by the current zero point are displayed. If the display box
includes an Edit button, you can select it to edit the element.

Note
This function is useful for making minor changes to the geometry
designed to remedy shortcomings (particularly missing intersections)
in the CAD drawing.
Use the geometry processor to make bigger changes.
You cannot undo changes once they have been made.

Layer selection:
A selected DXF file is always displayed initially with all its layers. If the
file contains several layers, these are all displayed in the basic view.
It is possible, however, to hide layers which do not contain any data
relevant to the contour. It is also possible to select contours that are
defined over several layers in a selection box for the contour trace.
Layer selections cannot be undone.
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Turn contour
This button rotates the drawing by 90 degrees each time about the
defined zero point according to the default settings. Existing contours
are not rotated at the same time.

Show hatching and dimensions
This button shows or hides hatching and dimensions in CAD drawings.
The function is reset again when you click the button again.

Delete contour trace
You can select and completely delete contours that are already
defined. The "Delete contour" function is activated when you select
this button once and deactivated when you click it again. Delete
finished contours:
• Click button: Activate "Delete contour"
• Select contour: Contour is deleted

Delete geometry element
You can use this function to delete individual geometry elements. It is
activated when you click the button once and deactivated when you
click it again. Delete geometry element:
• Click button: Activate "Delete geometry element"
• Select element: Geometry element is deleted

Delete geometry area
A whole area selected by a rectangle drawn with the mouse (defining
the area to be deleted) can be deleted from the geometry when you
click this button. Every time you delete an area, the function is
automatically deactivated and must be re-activated explicitly via this
button.
• Select button: Activate "Delete geometry area"
• Select area: Geometry area is deleted
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Notes
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3.1 Additional settings and displays

Edit The global "Edit" menu contains alternative commands to the toolbar
such as Set Contour Points/Drill Points, Select Layers, Rotate Contour
or Set Zero Point.

View →→→→ Status Line You can show the status line by selecting "View → View Status Line".
The coordinates of the axis names (X, Y) and the target system
(standard) are displayed in the status line.

Settings Select contour trace or drill point
Choose whether to accept contours or select drill points.

Contour trace →→→→ element or intersection
This function applies to the contour trace and undo.
Element: All intersections in the current element are 

included and displayed.
Intersection: Only the next intersection in each case is 

displayed.
Auto Zoom
When selection options are chosen for the contour trace, the elements
included in the selection are automatically zoomed in each case.
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Colors
You can set the number and names of the settable colors for individual
contour elements in the Colors menu.
The system defaults become effective again when you select
"Default".

Axis names
Axis names are specified with the relevant plane in the contour
display, e.g.:
• Axis names: 1st axis X, 2nd axis Y, 3rd axis Z
• Interpolation parameters: 1st axis I, 2nd axis J, 3rd axis K

Capture radius
Here you can set the capture radius in millimeters within which the
elements are interpreted as being "associated". This enables you to
acquire and process imprecisely defined drawings.
A large capture radius increases the number of possible following
elements.

Options
Input screenform for selecting target systems or displayed plane as
well as settings for display and representation.
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Language
You can select the following standard languages for the dialogs of the
complete CAD Reader application:
•  German
•  English
•  French
•  Italian
•  Spanish.

To activate the new language, you must restart the CAD Reader.

Help Help
This document, including the application example, are provided as a
help.

Miscellaneous

You can move the toolbar to any position using the mouse.

■
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4.1 Example of application for a contour trace

Start the CAD Reader
You can start the CAD Reader program by double clicking this button.

Open the DXF file
Click the Open button to select a CAD drawing. The following screen
appears, e.g. on the PC

DXF file

CAD drawing of a shaft

Layer selection
The DXF file contains several layers which are all displayed via the
Layer Selection screen. "Deselect All" deselects the existing
•  layer "1" and
•  layer "0".
Select layer "1" and confirm with "OK".

Redraw
With Redraw you size the selected sub-area of the drawing to match
the window and display it again in optimized form.
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Layer selection view

CAD Reader for layer "1" in optimized display form.

Contour trace with start and end points
Click this button to start the contour trace and select "Element center"
in the selection menu which then appears.
Move the mouse to the desired start element and select the direction
with the mouse (always click the small triangle). Move the arrow with
the mouse in the right direction and select the next corner point.

Element center

Select the element center and contour trace in direction of arrow.
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Back
The contour is automatically undone as far as possible to the last valid
position. If the wrong element has been selected in the contour trace,
it is possible to undo the last action either element by element or to the
last intersection depending on your selection.

Set and select the end point
The end point is activated when you click the "Set contour end point
button". You select the end point in selection menu "Element end
point" and position it as required in the element using the mouse. The
end point is represented by a full square as shown in the following
screenshot.

Element end point

Select and position element end point.

Save the program
Save the program as an MPF file. When a program is saved, G code
is generated from the selected contour.

■



A 03.02 Appendix
References A

© Siemens AG, 2002. All rights reserved
SINUMERIK 840D/840Di/810D Operator's Guide CAD Reader (CAD) – 03.02 Edition A-35

Appendix

A References
General Documentation

/BU/ SINUMERIK 840D/840Di/810D/802S, C, D
Ordering Information
Catalog NC 60
Order No.: E86060-K4460-A101-A8-7600

/ST7/ SIMATIC
SIMATIC S7 Programmable Logic Controllers
Catalog ST 70
Order No.: E86060-K4670-A111-A3-7600

/Z/ SINUMERIK, SIROTEC, SIMODRIVE
Accessories and Equipment for Special-Purpose Machines
Catalog NC Z
Order No.: E86060-K4490-A001-A7-7600

Electronic Documentation

/CD1/ The SINUMERIK System
DOC ON CD (09.02 Edition)
(with all SINUMERIK 840D/840Di/810D and
SIMODRIVE publications)
Order No.: 6FC5 298-6CA00-0BG3
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User Documentation

/AUK/ SINUMERIK 840D/810D
Short Guide AutoTurn Operation (08.02 Edition)
Order No.: 6FC5 298-4AA30-0BP3

/AUP/ SINUMERIK 840D/810D
AutoTurn Graphic Programming System (02.02 Edition)
Operator’s Guide
Programming/Setup
Order No.: 6FC5 298-4AA40-0BP3

/BA/ SINUMERIK 840D/810D
Operator's Guide MMC (10.00 Edition)
Order No.: 6FC5 298-6AA00-0BP0

/BAD/ SINUMERIK 840D/840Di/810D
Operator's Guide: HMI Advanced (08.02 Edition)
Order No.: 6FC5 298-6AF00-0BP2

/BEM/ SINUMERIK 840D/810D
Operator's Guide HMI Embedded (08.02 Edition)
Order No.: 6FC5 298-6AC00-0BP2

/BAH/ SINUMERIK 840D/840Di/810D
Operator's Guide HT 6 (HPU new) (03.02 Edition)
Order No.: 6FC5 298-0AD60-0BP2

/BAK/ SINUMERIK 840D/840Di/810D
Short Operating Guide (02.01 Edition)
Order No.: 6FC5 298-6AA10-0BP0

/BAM/ SINUMERIK 810D/840D
Operator's Guide ManualTurn (08.00 Edition)
Order No.: 6FC5 298-5AD00-0BP0

/BAS/ SINUMERIK 840D/810D
Operator's Guide ShopMill (08.02 Edition)
Order No.: 6FC5 298-6AD10-0BP1

/BAT/ SINUMERIK 840D/810D
Operator's Guide ShopTurn (08.02 Edition)
Order No.: 6FC5 298-6AD50-0BP2
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/BAP/ SINUMERIK 840D/840Di/810D
Operator’s Guide Handheld Programming Unit (04.00 Edition)
Order No.: 6FC5 298-5AD20-0BP1

/BNM/ SINUMERIK 840D/840Di/810D
User’s Guide Measuring Cycles (08.02 Edition)
Order No.: 6FC5 298-6AA70-0BP2

/CAD/ SINUMERIK 840D/840Di/810D
Operator's Guide CAD Reader (03.02 Edition)
Order No.: (included in the online help)

/DA/ SINUMERIK 840D/840Di/810D
Diagnostics Guide (02.02 Edition)
Order No.: 6FC5 298-6AA20-0BP2

/KAM/ SINUMERIK 840D/810D
Short Guide ManualTurn (04.01 Edition)
Order No.: 6FC5 298-5AD40-0BP0

/KAS/ SINUMERIK 840D/810D
Short Guide ShopMill (04.01 Edition)
Order No.: 6FC5 298-5AD30-0BP0

/KAT/ SINUMERIK 840D/810D
Short Guide ShopTurn (07.01 Edition)
Order No.: 6FC5 298-6AF20-0BP0

/PG/ SINUMERIK 840D/840Di/810D
Programming Guide Fundamentals (08.02 Edition)
Order No.: 6FC5 298-6AB00-0BP2

/PGA/ SINUMERIK 840D/840Di/810D
Programming Guide Advanced (08.02 Edition)
Order No.: 6FC5 298-6AB10-0BP2

/PGK/ SINUMERIK 840D/840Di/810D
Short Guide Programming (02.01 Edition)
Order No.: 6FC5 298-6AB30-0BP1

/PGM/ SINUMERIK 840D/840Di/810D
Programming Guide ISO Milling (08.02 Edition)
Order No.: 6FC5 298-6AC20-0BP2
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/PGT/ SINUMERIK 840D/840Di/810D
Programming Guide ISO Turning (08.02 Edition)
Order No.: 6FC5 298-6AC10-0BP2

/PGZ/ SINUMERIK 840D/840Di/810D
Programming Guide Cycles (08.02 Edition)
Order No.: 6FC5 298-6AB40-0BP2

/PI/ PCIN 4.4
Software for Data Transfer to/from MMC Module
Order No.: 6FX2 060-4AA00-4XB0 (Ger., Engl., Fr.)
Order from: WK Fürth

/SYI/ SINUMERIK 840Di
System Overview (02.01 Edition)
Order No.: 6FC5 298-6AE40-0BP0
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Manufacturer/Service Documentation

a) Lists
/LIS/ SINUMERIK 840D/840Di/810D

SIMODRIVE 611D
Lists (02.02 Edition)
Order No.: 6FC5 297-6AB70-0BP2

b) Hardware
/BH/ SINUMERIK 840D/840Di/810D

Operator Components Manual (HW) (08.02 Edition)
Order No.: 6FC5 297-6AA50-0BP2

/BHA/ SIMODRIVE Sensor
Absolute Encoder with Profibus DP
User's Guide (HW) (02.99 Edition)
Order No.: 6SN1 197-0AB10-0YP1

/EMV/ SINUMERIK, SIROTEC, SIMODRIVE
EMC Installation Guideline (06.99 Edition)
Planning Guide (HW)
Order No.: 6FC5 297-0AD30-0BP1

/PHC/ SINUMERIK 810D
Configuring Manual (HW) (03.02 Edition)
Order No.: 6FC5 297-6AD10-0BP0

/PHD/ SINUMERIK 840D
NCU 561.2-573.4 Configuring Manual (HW) (08.02 Edition)
Order No.: 6FC5 297-6AC10-0BP2

/PMH/ SIMODRIVE Sensor
Measuring System for Main Spindle Drives
Configuring/Installation Guide, SIMAG-H (HW) (05.99 Edition)
Order No.: 6SN1197-0AB30-0BP0
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c) Software
/FB1/ SINUMERIK 840D/840Di/810D

Description of Functions Basic Machine (Part 1) (08.02 Edition)
(the various sections are listed below)
Order No.: 6FC5 297-6AC20-0BP2

A2 Various Interface Signals
A3 Axis Monitoring, Protection Zones
B1 Continuous Path Mode, Exact Stop and Look Ahead
B2 Acceleration
D1 Diagnostic Tools
D2 Interactive Programming
F1 Travel to Fixed Stop
G2 Velocities, Setpoint/Actual Value Systems, Closed-Loop Control
H2 Output of Auxiliary Functions to PLC
K1 Mode Group, Channels, Program Operation Mode
K2 Axes, Coordinate Systems, Frames,

Actual-Value System for Workpiece, External Zero Offset
K4 Communication
N2 EMERGENCY STOP
P1 Transverse Axes
P3 Basic PLC Program
R1 Reference Point Approach
S1 Spindles
V1 Feeds
W1 Tool Compensation

/FB2/ SINUMERIK 840D/840Di/810D(CCU2)
Description of Functions, Extended Functions (Part 2) (08.02 Edition)
including FM-NC: Turning, Stepping Motor
(the various sections are listed below)
Order No.: 6FC5 297-6AC30-0BP2

A4 Digital and Analog NCK I/Os
B3 Several Operator Panels and NCUs
B4 Operation via PC/PG
F3 Remote Diagnostics
H1 Jog with/without Handwheel
K3 Compensations
K5 Mode Groups, Channels, Axis Replacement
L1 FM-NC Local Bus
M1 Kinematic Transformation
M5 Measurements
N3 Software Cams, Position Switching Signals
N4 Punching and Nibbling
P2 Positioning Axes
P5 Oscillation
R2 Rotary Axes
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S3 Synchronous Spindles
S5 Synchronized Actions (up to SW 3/ thereafter /FBSY/)
S6 Stepper Motor Control
S7 Memory Configuration
T1 Indexing Axes
W3 Tool Change
W4 Grinding

/FB3/ SINUMERIK 840D/840Di/810D(CCU2)
Description of Functions, Special Functions (Part 3) (08.02 Edition)
(the various sections are listed below)
Order No.: 6FC5 297-6AC80-0BP2

F2 3-Axis to 5-Axis Transformation
G1 Gantry Axes
G3 Cycle Times
K6 Contour Tunnel Monitoring
M3 Coupled Motion and Leading Value Coupling
S8 Constant Workpiece Speed for Centerless Grinding
T3 Tangential Control
TE1 Clearance Control
TE2 Analog Axis
TE3 Speed/Torque Coupling Master-Slave
TE4 Transformation Package Handling
TE5 Setpoint Exchange
TE6 MCS Coupling
TE7 Retrace Support
TE8 Clock-Independent Path-Synchronous Output of Switching Signal
V2 Preprocessing
W5 3D Tool Radius Compensation

/FBA/ SIMODRIVE 611D/SINUMERIK 840D/810D
Description of Functions Drive Functions (08.02 Edition)
(the various sections are listed below)
Order No.: 6SN1 197-0AA80-0BP9

DB1 Operational Messages/Alarm Reactions
DD1 Diagnostic Functions
DD2 Speed Control Loop
DE1 Extended Drive Functions
DF1 Enable Commands
DG1 Encoder Parameterization
DM1 Calculation of Motor/Power Section Parameters and Controller Data
DS1 Current Control Loop
DÜ1 Monitors/Limitations
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/FBAN/ SINUMERIK 840D/SIMODRIVE 611 DIGITAL
Description of Functions ANA MODULE (02.00 Edition)
Order No.: 6SN1 197-0AB80-0BP0

/FBD/ SINUMERIK 840D
Description of Functions Digitizing (07.99 Edition)
Order No.: 6FC5 297-4AC50-0BP0

DI1           Start-up
DI2           Scanning with Tactile Sensors (scancad scan)
DI3           Scanning with Lasers (scancad laser)
DI4           Milling Program Generation (scancad mill)

/FBDN/ IT Solutions
NC Data Management Server (DNC NT-2000)
Description of Functions (01.02 Edition)
Order No.: 6FC5 297-5AE50-0BP2

/FBDT/ SINUMERIK 840D/840Di/810D
IT Solutions
NC Data Transfer (SinDNC)
Description of Functions (09.01 Edition)
Order No.: 6FC5 297-1AE70-0BP1

/FBFA/ SINUMERIK 840D/840Di/810D
Description of Functions (08.02 Edition)
ISO Dialects for SINUMERIK
Order No.: 6FC5 297-6AE10-0BP2

/FBFE/ SINUMERIK 840D/810D
Description of Functions Remote Diagnosis (11.01 Edition)
Order No.: 6FC5 297-0AF00-0BP1

FE1 Remote Diagnosis
FE2 Alarm-Controlled Notification per Email: @Event

/FBH/ SINUMERIK 840D/810D
HMI  Programming Package (10.01 Edition)
Order No.: (supplied with software)
Part 1 User's Guide
Part 2 Description of Functions
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/FBHLA/ SINUMERIK 840D/SIMODRIVE 611 digital
Description of Functions HLA Module (04.00 Edition)
Order No.: 6SN1 197-0AB60-0BP2

/FBMA/ SINUMERIK 840D/810D
Description of Functions ManualTurn (08.00 Edition)
Order No.: 6FC5 297-5AD50-0BP1

/FBO/ SINUMERIK 840D/810D
Description of Functions
Configuring OP 030 Operator Interface (09.01 Edition)
(the various sections are listed below)
Order No.: 6FC5 297-6AC40-0BP0

BA Operator’s Guide
EU Development Environment (Configuring Package)
PS Online only: Configuration Syntax (Configuring Package)
PSE Introduction to Configuring of Operator Interface
IK Screen Kit: Software Update and Configuration

/FBP/ SINUMERIK 840D
Description of Functions C-PLC Programming (03.96 Edition)
Order No.: 6FC5 297-3AB60-0BP0

/FBR/ SINUMERIK 840D/810D
IT Solutions
Description of Functions
Computer Link (SinCOM) (09.01 Edition)
Order No.: 6FC5 297-6AD60-0BP0

NFL Host Computer Interface
NPL PLC/NCK Interface

/FBSI/ SINUMERIK 840D/SIMODRIVE
Description of Functions (03.02 Edition)
SINUMERIK Safety Integrated
Order No.: 6FC5 297-6AB80-0BP1

/FBSP/ SINUMERIK 840D/810D
Description of Functions ShopMill (08.02 Edition)
Order No.: 6FC5 297-6AD80-0BP1

/FBST/ SIMATIC
Description of Functions
FM STEPDRIVE/SIMOSTEP (01.01 Edition)
Order No.: 6SN1 197-0AA70-0YP4
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/FBSY/ SINUMERIK 840D/810D
Description of Functions Synchronized Actions (08.02 Edition)
for Wood, Glass, Ceramics and Presses
Order No.: 6FC5 297-6AD40-0BP2

/FBT/ SINUMERIK 840D/810D
Description of Functions ShopTurn (08.02 Edition)
Order No.: 6FC5 297-6AD70-0BP2

/FBTC/ SINUMERIK 840D/810D
IT Solutions
SINUMERIK Tool Data Communication SinTDC (01.02 Edition)
Description of Functions
Order No.: 6FC5297-5AF30-0BP0

/FBTD/ SINUMERIK 840D/810D
IT Solutions
Tool Information (SinTDI) with Online Help (03.01 Edition)
Description of Functions
Order No.: 6FC5 297-6AE00-0BP0

/FBU/ SIMODRIVE 611 universal/universal E
Description of Functions (02.02 Edition)
Closed-Loop Control Component for Speed Control
and Positioning
Order No.: 6SN1 197-0AB20-0BP5

/FBW/ SINUMERIK 840D/810D
Description of Functions Tool Management (08.02 Edition)
Order No.: 6FC5 297-6AC60-0BP1

/FBWI/ SINUMERIK 840D/840Di/810D
Description of Functions WinTPM (02.02 Edition)
Order No.: document is supplied with software

/HBA/ SINUMERIK 840D/840Di/810D
Manual @Event (01.02 Edition)
Order No.: 6AU1900-0CL20-0AA0

/HBI/ SINUMERIK 840Di
Manual (09.02 Edition)
Order No.: 6FC5 297-6AE60-0BP1
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/INC/ SINUMERIK 840D/840Di/810D
SINUMERIK Start-Up Tool SinuCOM NC (02.02 Edition)
System Description
Order No.: (included in online help for Start-Up Tool)

/PFK/ SIMODRIVE
Planning Guide 1FT5/1FT6/1FK6 Motors (12.01 Edition)
Three-Phase AC Servo Motors for Feed and
Main Spindle Drives
Order No.: 6SN1197-0AB20-0BP0

/PJE/ SINUMERIK 840D/810D
Configuring Package HMI Embedded (08.01 Edition)
Description of Functions: Software Update, Configuration,
Installation
Order No.: 6FC5 297-6EA10-0BP0
(The publication "Configuring Syntax" is supplied with
software and is available as PDF file)

/PJFE/ SIMODRIVE
Planning Guide (09.01 Edition)
Synchronous Motors 1FE1
Three-Phase AC Motors for Main Spindle Drives
Order No.: 6SN1 197-0AC00-0BP1

/PJLM/ SIMODRIVE
Planning Guide Linear Motors (11.01 Edition)
(on request)
ALL General Information about Linear Motors
1FN1 Three-Phase AC Linear Motor 1FN1
1FN3 Three-Phase AC Linear Motor 1FN3
CON Connections
Order No.: 6SN1 197-0AB70-0BP2

/PJM/ SIMODRIVE
Planning Guide Motors (11.00 Edition)
AC Motors for Feed and Main Spindle Drives
Order No.: 6SN1 197-0AA20-0BP5

/PJU/ SIMODRIVE 611
Planning Guide Inverters (05.01 Edition)
Order No.: 6SN1 197-0AA00-0BP5
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/PMS/ SIMODRIVE
Planning Guide ECO Motor Spindle
for Main Spindle Drives (04.02 Edition)
Order No: 6SN1 197-0AD04-0BP0

/POS1/ SIMODRIVE POSMO A
User's Guide (04.01 Edition)
Distributed Positioning Motor on PROFIBUS DP
Order No.: 6SN2 197-0AA00-0BP2

/POS2/ SIMODRIVE POSMO A
Installation Instructions (enclosed with POSMO A) 

/POS3/ SIMODRIVE POSMO SI/CD/CA
Distributed Servo Drives, User's Guide (08.01 Edition)
Order No.: 6SN2 197-0AA20-0BP1

/PPH/ SIMODRIVE
Planning Guide 1PH2/1PH4/1PH7 Motors (12.01 Edition)
AC Asycnchronous Motors for Main Spindle Drives
Order No.: 6SN1197-0AC60-0BP0

/PPM/ SIMODRIVE
Planning Guide Hollow-Shaft Motors (10.01 Edition)
Hollow-Shaft Motors for Main Spindle Drives
1PM4 and 1PM6
Order No.: 6SN1197-0AD03-0BP0

/S7H/ SIMATIC S7-300
Manual: Assembly, CPU Data (HW) (10.98 Edition)
Reference Manual: Module Data
Order No.: 6ES7 398-8AA03-8AA0

/S7HT/ SIMATIC S7-300
Manual: STEP7, Basic Information, V3.1 (03.97 Edition)
Order No.: 6ES7 810-4CA02-8AA0

/S7HR/ SIMATIC S7-300
Manual STEP7, Reference Manuals, V3.1 (03.97 Edition)
Order No.: 6ES7 810-4CA02-8AR0
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/S7S/ SIMATIC S7-300
FM 353 Positioning Module for Stepper Drives (04.97 Edition)
Order in conjunction with Configuring Package

/S7L/ SIMATIC S7-300
FM 354 Positioning Module for Servo Drives (04.97 Edition)
Order in conjunction with Configuring Package

/S7M/ SIMATIC S7-300
FM 357.2 Multi-Axis Module for Servo and (01.01 Edition)
Stepper Drives
Order in conjunction with Configuring Package

/SP/ SIMODRIVE 611-A/611-D
SimoPro 3.1
Program for Configuring Machine-Tool Drives
Order No.: 6SC6 111-6PC00-0BA❏ ,
Order from: WK Fürth
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d) Installation
and Start-Up
/IAA/ SIMODRIVE 611A

Installation and Start-Up Guide (10.00 Edition)
Order No.: 6SN 1197-0AA60-0BP6

/IAC/ SINUMERIK 810D
Installation and Start-Up Guide (03.02 Edition)
(incl. description of SIMODRIVE 611D start-up software)
Order No.: 6FC5 297-6AD20-0BP0

/IAD/ SINUMERIK 840D/SIMODRIVE 611D
Installation and Start-Up Guide (08.02 Edition)
(incl. description of SIMODRIVE 611D start-up software)
Order No.: 6FC5 297-6AB10-0BP2

/IAM/ SINUMERIK 840D/840Di/810D
HMI/MMC Installation and Start-Up Guide (08.02 Edition)
Order No.: 6FC5 297-6AE20-0BP2

AE1 Updates/Options
BE1 Extend the Operator Interface
HE1 Online Help
IM2 HMI Embedded Start-Up (PCU 20)
IM4 HMI Advanced Start-Up (PCU 50)
TX1 Creating Foreign-Language Texts

▀
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I.1 Keyword Index

A

Adapt machine axis names  3-29
Additional Settings  3-27
Auto Zoom  3-28

C

CAD Reader
Scope of application  1-17

CAD Reader
Example of application  4-32
Formats  1-18
General function  1-16
Operation  2-20
Product  1-16

Cancel contour trace  2-22
Contour direction  2-22
Contour trace → element or intersection  3-28
Contour trace with start and end points  2-21

D

Define the zero point  2-21
Delete contour trace  2-25
Delete geometry area  2-25
Delete geometry element  2-25
Deselect the processing area  2-23
Drill points end  2-23
Drill points start  2-23

E

Editing elements  2-24
Example of Application  4-31

F

Full circle as contour  2-22
Full circle as drill hole  2-23

Functions  1-16

G

Geometry information  2-24
Capture radius for associated elements  3-29

H

Help and application example  3-30
How to Use the CAD Reader  2-19

I

Input format  1-18

L

Layer selection  2-24

N

Number and naming of colors  3-29

O

Open DXF files  2-20
Optimized display of current drawing  2-24
Output formats  1-18

P

Plane generation  1-18

S

Save a contour  2-20
Select a language  3-30
Select contour trace or drill points  3-28
Select options  3-29
Select processing area  2-23
Selection in the event of conflict  2-22
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Set drill points  2-23
Set the contour end point  2-22
Set the contour label  2-22
Set the contour start point  2-21
Set the zero point  2-21
Settings  3-28
Show hatching and dimensions  2-25
Software  1-17
Status line  3-28

T

Target systems  1-17
Toolbar  2-20
Turn contour  2-25

U

Undo last action in contour trace  2-20

Z

Zoom areas  2-24
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